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OPENOFFICE Overview 
OpenOffice.org sponsored by Sun Microsystems, has developed an open source office suite of products 
similar to Microsoft Office. 
The suite actually consists of five products: 

• Writer, word processing software for working with text documents 
• Calc, spreadsheet software 
• Impress, multimedia presentation software 
• Draw, drawing software for diagrams and illustrations 
• Database User Tools, for day-to-day database work in simple spreadsheet-like form. 

OpenOffice.org Download and Installation Procedures 
The OpenOffice.org.org product suite is available as a free download from the OpenOffice.org.org Web 
site at: http://www.openoffice.org/. 
OpenOffice Writer Overview 
OpenOffice.org Writer is a powerful tool for creating professional documents, reports, newsletters, and 
brochures. You can easily integrate images and charts into documents, create everything from business 
letters to complete books with professional layouts, as well as create and publish Web content. 

Writer is the official name for the software, even though the name does not appear in the current 
version of the software. 
To launch OpenOffice.org Writer: 

• Click the Start button in the lower left corner of the desktop. 
• Hover over the Programs menu selection. 
• Hover over the OpenOffice.org menu selection. 
• Hover over and click the Text Document menu selection. 

The Basics of the OpenOffice.org Window 

 

Title Bar 
Displays the document name followed by a program 
name. 
Menu Bar 
Lists commands in a menu style. 
Function Bar 
Includes icons for common actions: open, save, copy, 
cut, paste, etc. 
Command Bar  
Lists icons for formatting the text 
 Main Toolbar 
Includes specific tools you can use as you type to insert 
fields, forms, images, and other objects. 

Status Bar 
Displays information: the current page, current template, zoom percentage, insert or overwrite mode, 
selection mode, and hyperlink mode. 
Stylist Floating Window 
Displays options for you to change the style of the text with a few clicks. 
Navigator Floating Window 
Displays tools you can use as you type long documents with many chapters, sections, images, etc.  
NOTE: 
If the floating windows do not appear by default, you can display them by clicking on the Navigator 

icon and the Stylist icon . You can find these icons on the function bar.  
Change the OpenOffice.org Window View 
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To help you stay organized as you work, OpenOffice.org offers two different views for you to look at as 
you work through your document: Online Layout view and Full Screen view. 

• Online Layout view shows you what your document will look like when you print it. This is the 
default view. 

• Full Screen view displays ONLY the document that you are working on. All the other pieces of 
the OpenOffice.org window are removed except for one button that allows you to Close View 
Screen. 

To change a view: 

 

• Click View on the menu bar.  
• Select the view of your choice, either Online Layout or Full 

Screen. 

To Change the Toolbars View: 
• Choose View Toolbars on the menu bar. 

To Change the Rulers View: 
The Ruler runs across the page and is used for paragraph settings, tabs, etc. 

• Click View Rulers on the menu bar to turn this view on or off. 
To Change the Status Bar View: 
The Status Bar is represented at the bottom of the page and conveys general information about the 
document, such as page number, total pages, style name, view, insert mode, etc. 

• Click View Status Bar on the menu bar to turn this view on or off.  
To Change the Text Boundaries View: 
Text Boundaries shows or hides the printable area of the page. It is generally represented as a boxed 
outline on the page and into which all your typing is performed.  

• Click View Text Boundaries on the menu bar to turn this view on or off.  
To Change the Non-printing Characters View: 
Printing characters are those editorial marks that indicate the end of a paragraph, a line break, a 
character space, etc. Many people don't like to work with printing characters turned on. 

• Click View Non-printing Characters on the menu bar to turn this view on or off.  
Using the Pull-Down Menus 
Each OpenOffice.org program features a menu bar. The menu bar is made up of many different menus. 
Each menu contains commands that enable you to work within the program. Pull-down menus include 
the following components: 

• File 
• Edit 
• View 
• Insert 
• Format 
• Tools 
• Window 
• Help 
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Using the Object Bar 
Since OpenOffice.org Writer is a windows-based package, it has the ability to format text with a click of 
the mouse. All of these enhancements assume that you have selected the text before you format it. 

To apply a style Click a style in the Apply Styles stylist box. 

To change font with the mouse Click on the down arrow, next to the Font Name 
on the toolbar. 

 

To change font size with the 
mouse 

Click the down arrow next to the Font Size box. 
 

To add or remove bold, italics, 
or underline 

Click on the Bold, Italic, or Underline icon or 
press short keys (Ctrl + B, Ctrl + I, Ctrl + U) on 
the keyboard. 

 

To change alignment of text 
(Left, Center, Right, Justify)  

Click the appropriate alignment icon: Align Left, 
Centered, Align Right, or Justified.  

To add numbers to text Click on the Numbering On/Off icon. 
 

To add Bullets to text Click on the Bullets On/Off icon. 
 

To change the amount of 
indentation of the text 

Click on the Increase Indent or Decrease Indent 
icons.  

To change the color of text Click on the Font Color icon. 
 

To highlight text Click on the Highlight icon. 
 

To change the paragraph 
background color 

Click on the Paragraph Background icon. 
 

Using the Function Bar 

To open a different OpenOffice.org 
Writer document in a new window 

Click on the down arrow next to Load URL 
on the toolbar. 

 

To create a new file, open an existing 
file, or save a file 

Click the New, Open File, and Save 
Document icons to perform function 
shortcuts in the File menu. 

 

To print a file to a PDF file or to a 
printer 

Click the Export Directly as PDF or Print 
File Directly icons to perform the print 
functions in the File menu. 

 

To cut, copy, and paste text or 
images, or to undo or redo editorial 
operations  

Click the Cut, Copy, Paste, Undo, and Redo 
icons to perform the edit functions in the 
Edit menu. 

 

Main Toolbar 

To insert a table into the document  Click the Insert icon. 
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To insert a field into the document  Click the Insert Fields icon. 
 

To insert a chart into the document  Click the Insert Object icon. 
 

To insert drawing objects like a line, rectangle, ellipse, polygon, 
curve, text, callout, etc. into the document  

Click the Show Draw Functions 
icon.  

To insert form elements like a push button, check box, text box, 
list box, etc. into the document  

Click the Show Form Functions 
icon.  

To turn the direct cursor to the on or off position  Click the Direct Cursor On/Off 
icon.  

To perform spellcheck against the document  Click the Spellcheck icon. 
 

To turn AutoSpellcheck to the on or off position Click the AutoSpellcheck 
On/Off icon.  

To perform a Find or Find-and-Replace operation against the 
document  

Click the Find On/Off icon. 
 

To turn non-printing characters to the on or off position  Click the Non-printing 
Characters On/Off icon.  

To turn the display of graphics to the on or off (a placeholder 
appears instead of a graphic) position  

Click the Graphics On/Off icon. 
 

To turn the online layout view to the on or off position  Click the Online Layout icon. 
 

Understanding File Menu 
New: Used to create a new file. 
Open: Used to open an existing file from a floppy disk or hard drive of your computer. 
Close: Used to close a file. 
Save: Used to save a file after making changes. If you close the text document without saving, all of your 
changes will be lost. 
Save As: Used to save a new file for the first time or save an existing file with a different name. 
Save All: Used to save all open files when you make changes to them. 
Creating a New File  
A blank, text editor palette is displayed when you first open OpenOffice.org. You can type information 
directly into this blank palette.  
To create an OpenOffice.org text document: 

• Choose File New Text Document from the menu bar.  

 
• A blank, text editor palette opens in the OpenOffice.org window. 

To save and name a new file: 
• Choose File Save As/Save from the menu bar.  
• The Save As dialog box appears. 
• Click on the Save In: Drop-down menu and locate where you want to save the file.  
• Type a name for your file in the File Name: box.  
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• Click the Save button. 

 
Saving a Previously-Named File 
To save changes to an existing text file: 

• Choose File Save from the menu bar.  
To close an existing Writer document: 

• Choose File Close from the menu bar. The Writer document window is now closed. 
To Open an Existing OpenOffice.org Text File: 

• Choose File Open from the menu bar.  
• The Open dialog box opens. 

 
• In the Look in list, click the drive, folder  that contains the file you want to open.  
• In the folder list, open the folder that contains the file. Once the file is displayed, click on the file 
• Click the Open button.  

Exiting OpenOffice.org 
To Exit the OpenOffice.org Writer Software: 

• Choose File Exit from the menu bar.  
The Insertion Point and the I-Beam 
The insertion point is the blinking line in the OpenOffice.org document that indicates where you insert 
text into the document when you type. The I-Beam is the cursor that moves around the screen when 
you move the mouse over text. 
Delete and Backspace Keys 
You can delete text to the left and right of the insertion point by using the Delete and Backspace keys, 
respectively. 
Undo and Repeat 
The Undo feature lets you delete the last change made to your document.  
To Undo the Last Operation Performed: 

• Choose Edit Undo. (Ctrl + Z)  
OR  
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• Undo all your recent actions by repeatedly clicking the Undo button.  

This command is located on the Standard toolbar.  
Notice the small list arrow at the top of the Undo button. Click and hold it, a list of all the separate 
actions performed will appear You can select as many actions as you want to undo. 

 
To Repeat the Last Undo:  

• Choose Edit Redo from the menu bar. (Ctrl + Y)  
OR  

• Repeat any previous Undo operations by clicking the Repeat button located on the Standard 
toolbar.  

Insert vs. Overtype Mode 
Insert mode is the default mode for editing in OpenOffice.org Writer. Insert mode adds text, but does 
not erase anything.  
Overtype mode is useful when you want to replace a series of words. In this mode, the text you type 
replaces any existing text to the right of the insertion point and erases it.  
Selecting Text 

Any Text (Option 1) Click and hold at the beginning of the selection and drag mouse to the 
end of the selection (click-and-drag). 

Any Text (Option 2) Click at the beginning of the selection, hold down Shift and click at the 
end of selection (shift-clicking). 

Word Double click in OpenOffice.org Writer. 

Sentence Hold Ctrl and click on the sentence. 

Line With mouse pointer in left margin, point to line and click. 

Paragraph With mouse pointer in paragraph, triple click. 

Entire document (Option 1) Hold Ctrl and Press A. 

Entire document (Option 2) Hold CTRL on the keyboard and click the mouse in the left margin. 

One letter at a time Position the cursor at the beginning of the text, hold down Shift and use 
arrow keys to the end of selection. 

From the cursor to the 
beginning of the line 

Shift + Home 

From the cursor to the end of 
the line 

Shift + End 

Using the Keyboard to Select Text 
Many people use the keyboard to select text. 

Shift + Right Arrow Character to the right of the insertion point 

Shift + Left Arrow Character to the left of the insertion point 
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Shift + Home All of the current line to the left of the insertion point 

Shift + End All of the current line to the right of the insertion point  

Shift + PgUp  A screenful of text from the insertion point up 

Shift + PgDn  A screenful of text from the insertion point down 

Ctrl + Shift + Right Arrow  One word to the right of the insertion point  

Ctrl + Shift + Left Arrow One word to the left of the insertion point 

Crtl + Shift + Home  All text from insertion point to the beginning of the document  

Crtl + Shift + End  All text from the insertion point to the end of document  

Alt + Ctrl + Shift + PgDn  All text from the insertion point to end of the displayed window  

F8 and Arrow Key  From the insertion point in the direction of whichever arrow chosen.  
F8 turns on selection mode; press Esc to leave selection mode.  

Crtl + A  Selects entire document 

To Print Preview: 
• Choose File Page Preview on the menu bar. 

To Print a Text Document: 
• Choose File Print from the menu bar. 
• The Print dialog box opens. 

 
• Specify the Name of the printer where you would like to print your document. If you only have 

one printer in your home or office, OpenOffice.org will default to that printer.  
• In Print Range, choose whether to print All or a certain range of pages (Pages From n to y, 

where n and y are the beginning and ending page numbers.  
• Choose the Number of Copies to print by clicking on the up or down arrows.  
• Click the OK button to print the OpenOffice.org document.  

Changing the OpenOffice.org Printer Settings 
To Change the OpenOffice.org Printer Settings: 

• Choose File Printer Settings  from the menu bar. 
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• The Printer Setup dialog box opens. 
Click the Properties button. 

 
• Define the page Orientation as portrait or landscape. 
• Define the Page Order as to print front-to-back or back-to-front.  
• Define the Pages Per Sheet that you would like to print. To conserve paper, you can print 2 

pages on the same sheet of paper. OpenOffice.org will reduce the size of the text so that every 
two pages print on only one sheet of paper. 

• Click the OK button to change the printer settings.  
To Run Spellcheck: 

• Choose Tools Spellcheck Check from the menu bar.  
• The Spellcheck dialog box displays the first incorrectly-spelled Word in the document, as well as 

Suggestions to the closest possible matches contained in the OpenOffice.org.org dictionary.  
Using AutoSpellcheck 
AutoSpellcheck easily identifies misspelled words on the page as you type the document. Any word 
that you misspell is immediately underlined with a red wavy line. By visually seeing this error as you 
type, the misspelled word can be immediately corrected. 
To Enable AutoSpellcheck: 

• Choose Tools Spellcheck AutoSpellcheck from the menu bar, or click the AutoSpellcheck 
On/Off icon on the Main Toolbar.  

• Right-click on any word that reveals a red wavy underline, then choose a suggested replacement 
word from the list.  

• The correction is applied to the document. 
Using AutoCorrect/AutoFormat 
To Define Entries in AutoCorrect: 

• Choose Tools AutoCorrect/AutoFormat from the menu bar.  
• Click the Replace tab on the AutoCorrect dialog box.  
• In the Replace field, type the word or abbreviation that you want to replace while you type. If 

you frequently misspell "about" as "abotu" then type "abotu" in the Replace field. 
• In the With field, type the replacement text that you want to use to replace the text in the Replace 

box. For the "abotu" Replace field entry in the last button, you might define "about" in the With 
field. 

• Click the OK button. 
Clipboard 
The Clipboard is a temporary storage file in your computer's memory. Items that you place on the 
Clipboard will remain there until you exit OpenOffice.org. 
Cut, Copy, Paste 
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The Cut, Copy, and Paste operations also appear as choices in the Edit menu 
You can also perform Cut, Copy, and Paste functions through shortcut keys: 

• Cut, Ctrl+X 
• Copy, Ctrl+C 
• Paste, Ctrl+V 

Cut feature, allows you to remove selected text from the document and temporarily place it on the 
Office Clipboard.  
Copy feature that allows you to copy selected text from the document and temporarily place it on the 
Clipboard 
Paste feature allows to get text from the Clipboard and place it in the same document or even in another 
document.  
To Cut and Paste a Block of Text: 

• Select the text you want to move.  

• Click the Cut button on the Standard Toolbar.  
• Place the insertion point where you want to insert the text.  

• Click the Paste button .  
To Copy and Paste a Block of Text: 

• Select the text you want to move.  

• Click the Copy button on the Standard Toolbar.  
• Place the insertion point where you want the text inserted.  

• Click the Paste button .  
Using Drag-and-Drop 
The drag-and-drop method of moving text allows you to move selected text using your mouse. This 
method is convenient for moving text when: 

• Moving text from one location to another within a document.  
• Moving text to another document.  

To Drag and Drop Selected Text: 
Drag:  

• Select the text you wish to move.  
• Place the mouse pointer anywhere on the selected text without clicking.  
• Left click and drag the selected text to the new location.  

Drop: 
• During this process, the mouse pointer changes to a box with a small white arrow over it, 

indicating you are dragging text.  
• When you reach the new location, release the mouse button to drop the text into place.  

Using the Align Buttons 
Text alignment options: 

• Left-Aligned: The most common form where each line is flush with the left margin. 
• Centered: Each line is centered on the page. 
• Right-Aligned: Each line is flush with the right margin. 
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• Justified: Every line is flush with the left and right margin. Note: The option can make text 
harder to read by adding spaces between words. 

Using the Align Buttons (continued) 
To Align Text Using the Alignment Buttons: 

• Select or Click anywhere inside the paragraph you want to align.  
• Click the Align Left, Center, Align Right, or Justify button on the Formatting toolbar.  

To Align Text Using Menu Selection: 
• Choose Format Paragraph from the menu bar. 
• Click the Alignment tab on the Paragraph dialog box.  
• Click either the Left, Right, Center, or Justified radio buttons under Options.  

To Create an Indented Paragraph:  
• Position the insertion point to any location in the paragraph (or click-and-drag to select multiple 

paragraphs) you want to format 
• Choose Format Paragraph.  
• Click the Indents & Spacing tab on the Paragraph dialog box.  
• In the Before text field, enter the amount (or used the up/down arrows) by which you want to 

indent a paragraph from the left page margin. If you want the paragraph to extend into the left 
page margin, enter a negative number. 

• In the After text field, enter the amount (or used the up/down arrows) by which you want to 
indent a paragraph from the right page margin. If you want the paragraph to extend into the 
right page margin, enter a negative number. 

• In the First line field, enter the amount (or used the up/down arrows) by which you want to 
indent the first line of a paragraph. 

• Click the OK button. 

Remember, there is a difference between indents and tabs. If you set a tab, only one line of text is 
indented. If you click one of the indent buttons or set an indent in the Paragraph dialog box, all of the 
text you type afterwards will be indented. 
Defining Paragraph Spacing 
The paragraph spacing option allows you to add additional space between paragraphs, headings, or 
subheadings as you type your document. Extra spacing between paragraphs adds emphasis and makes 
a document easier to read. 

• Position the insertion point to any location in the paragraph (or click-and-drag to select multiple 
paragraphs) you want to format 

• Choose Format Paragraph.  
• Click the Indents & Spacing tab on the Paragraph dialog box.  
• In the Above paragraph field, enter the amount (or used the up/down arrows) of space that you 

want to leave above the selected paragraph(s). 
• In the Below paragraph field, enter the amount (or used the up/down arrows) of space that you 

want to leave below the selected paragraph(s). 
• Click the OK button. 

Defining Line Spacing 
Line spacing often determines how easy it is to read a document. Line spacing is measured in lines or 
points and is referred to as leading (pronounced ledding). Reducing leading makes the lines closer 
together and can make a text difficult to read. However, if you increase the leading, you can increase 
your document's readability. You may change line spacing to single, double, or one and a half space 
increments. 

• Position the insertion point to any location in the paragraph (or click-and-drag to select multiple 
paragraphs) you want to format 

• Choose Format Paragraph.  
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• Click the Indents & Spacing tab on the Paragraph dialog box.  
• The Line Spacing drop-down box specifies the type of line spacing that you can use between 

lines of text in a paragraph. Choices include: 
• Single -- Applies single line spacing to the current paragraph. This is the default setting. 
• 1.5 lines -- Sets the line spacing to one and half lines. This corresponds to a vertical space that is 

half of the font height. 
• Double -- Sets the line spacing to two lines. This corresponds to a vertical space that is equal to 

the font height. 
• Proportional -- Select this option and then enter a percentage value in the box, where 100% 

corresponds to single line spacing. 
• At Least -- Sets the minimum line spacing to the value that you enter in the box. 
• Leading -- Sets the height of the vertical space that is inserted between two lines. 
• Fixed -- Sets the line spacing to exactly match the value that you enter in the box. This can result 

in cropped characters. 
The Ruler 
The ruler provides a visual tool that allows you to quickly view, create, and change your documents 
tabs, margins, and indents. 
The default unit of measurement on the ruler is inches. 
To hide and display the ruler: 

• Choose View Ruler on the menu. 
Setting Tabs Using the Ruler 
Click on the small, gray box to the left of the ruler to move through the four different Tab Settings. 
To hide and display the ruler: 

• Left tab : Moves text toward the right edge of the page as you type.  

• Center tab : Centers text around the tab.  

• Right tab : Moves text toward the left edge of the page as you type.  

• Decimal tab : Aligns decimal numbers using the decimal point.  
To Place a Tab or Indent On The Ruler: 

• Click the cursor anywhere in the block of text you want to format.  
• Click the tab selection button (upper left of the ruler).  
• Click the location on the Ruler where you want to set your tab or indent. e.g., 2 inches).  
• If you set up a new tab, press the tab key to move your text to the new tab.  
• If you set up a new indent, place the cursor at the new indent location. 

To Change a Tab Stop Type: 
• Click anywhere in the paragraph that contains the tab stop that is to change.  
• Right-click on the tab stop on the horizontal ruler. 
• Select a different tab type from the drop-down menu. 

Adjusting Tab Settings on the Ruler 
To Move an Existing Tab or Indent on the Ruler: 

• Point the mouse cursor to the tab or indent that you want to move.  
• Click-and-hold the left mouse button until a dotted line that runs down the page is displayed on 

the screen.  
• Drag the mouse to the left or right to move the tab or indent to its new location.  
• Release the left mouse button.  

To Move Several Tabs Stops On The Ruler: 
• Press the Shift key before you click a tab.  
• Point the mouse cursor to the tab or indent that you want to move.  
• Click-and-hold the left mouse button as you drag the cursor to the right or left. Make sure the 

Shift is still pressed down as you drag the cursor.  
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Notice how the tab you selected as well as the other tabs to the right of it move as the cursor is 
dragged across the screen. The spacing between those tabs remains the same.  

To Remove a Tab from the Ruler: 
• Point the mouse cursor to the tab or indent that you want to remove.  
• Click-and-hold the left mouse button until a dotted line that runs down the page is displayed on 

the screen.  
• Drag the mouse off the Ruler.  
• Release the left mouse button.  

Using the Ruler to Change Margin Settings 
To Adjust a Paragraph Margin using the Ruler: 

• Click the cursor anywhere in the paragraph that will have its settings changed.  
• Point the mouse on to the left-margin icon in the ruler.  
• Click-and-hold the left mouse and drag the cursor to increase or decrease the paragraph margin 

on the ruler. 
• Release the left mouse button.  

About Font Styles 
Fonts come in three basic types: 

This is an example of a serif font. A serif font has lines, curves or edges extending from the straight 
lines of each letter. Serif fonts are easy to read, especially in long documents.  

This is an example of a Sans Serif Font. A sans serif font has no additional strokes or ornaments to 
the basic letter shape. Sans serif fonts are very clean and clear and are ideal for headings and short 
documents.  

This is an example of a Script font. Script fonts are similar to handwriting. Although they may look 
very nice, they can be difficult to read. Script fonts are best suited for invitations or other decorative 
documents. 

The default font in OpenOffice.org Writer, New Times Roman, is an example of a serif font.  
Changing the Font, Typeface, and Size 
To Change a Font: 

• Highlight the selected text.  
• Choose Format Character from the menu bar.  
• Click the Font tab on the Character dialog box.  
• To select a font, scroll through the font list and stop at the one you want to use. The font list 

shows you all the fonts that are available on the computer you are using. As you scroll through 
the list a preview of the font is displayed in the preview window.  

• Click the OK button to apply the new definitions to the selected text. 
To Change the Typeface and Size: 

• Highlight the selected text.  
• Choose Format Character from the menu bar.  
• Click the Font tab on the Character dialog box.  
• To change the typeface of a font, scroll through the size list and stop at the one you want to use. 

Available typefaces include: 
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• To change the size of a font, scroll through the size list and stop at the one you want to use. You 
can use different font sizes to give emphasis to different parts of your document. Font size is 
commonly expressed in points. Font sizes range from 8 point (extremely small) to 72 point (very 
big), but the standard font size for most documents is 12 Point. 

• Click the OK button to apply the new definitions to the selected text. 
Using the Formatting Toolbar 
The most commonly used Font tools (except for preview) are available on the Formatting toolbar. The 
Formatting toolbar allows you to change font name, font size, and font style. OpenOffice.org Writer lets 
you display text as bold, italicized, or underlined, regardless of the font and font size you choose. 

 
To Change the Font Using the Formatting Toolbar:  

• Select the text you want to change. 
• Choose one or more of the following, depending on how you want your text to look.  

o Click the Bold button on the Formatting toolbar. (Ctrl + B)  
o Click the Italic button on the Formatting toolbar. (Ctrl + I)  
o Click the Underline button on the Formatting toolbar. (Ctrl + U)  

• OpenOffice.org Writer automatically displays your changes. 
To Change Text Color: 
• Select the text you want to change.  

 

• If the color displayed in the Font Color button is the color you want to apply to 
the text, click it once. Otherwise, click-and-hold the Font Color button. A color 
palette will appear.  

• Click once on the color you want to apply to the selected text.  
• OpenOffice.org Writer will then change the color of the text. 

About Bulleted and Numbered Lists 
Writer allows you to make two types of lists: bulleted and numbered.  

 
To create a bulleted list: 

• Click the button on the Formatting toolbar.  
• Type the first item on your list and press Enter.  
• The second bullet will automatically display on the next line. 
• When the list is complete, press Enter twice to turn off the bulletting function.  

To create a sub-bulleted list: 
• Insert an empty bullet where you want to begin, either in the middle of a bulleted list, or at the 

end of a bulleted list.  
• Press the right indent button to indent the sub-bulleted list. 
• Type the first item on your list and press Enter. The second bullet will automatically display on 

the next line. 
• When the list is complete, press Enter twice to turn off the bulleting function.  

To change a numbered list to a bulleted list: 
• Select the entire list.  
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• Click the button twice on the Formatting toolbar. The first time you click the number will 
disappear. The second time you click a bullet will appear. 

To remove a bullet: 
• Place the insertion point anywhere in the line where the bullet is to be removed. 

• Click the button on the Formatting toolbar.  
To change the appearance of bullets: 

• Select the bullets that you want to change. 
• Choose Format Numbering/Bullets on the menu bar. 
• Depending on how you want your list to appear, click on either the Bullets tab or the Graphics 

tab.  

  
• Click once on the specific type of bullet (from the 8 displayed) or graphic (from the 12 displayed) 
• Click on the OK button.  

To create a numbered list:  

• Click on the button on the Formatting toolbar.  
• Type the first item on your list and press Enter.  
• The second bullet will automatically display on the next line. 
• When the list is complete, press Enter twice to turn off the numbering function.  

To create a line break between items in a numbered list: 
• Place your cursor where you want to insert a line break. 
• Press Shift + Enter. 

Additional Numbering and Bulleted Options 
The final three tabs in the Numbering/Bullets dialogue box allow you to do the following functions: 

• Outline -- Click the Outline tab to see the different symbols used in the different outline 
structures. You can select the outline that best suits your document. 

• Position -- Click the Position tab to see the different settings (indent, alignment, etc.) assigned to 
each Outline level. 

• Options -- The Options tab, like the Position tab, allows you to define additional formatting 
measurements (e.g., before and after spacing) assigned to each Outline level. 

Adding a Table to the Document 
Tables allow you to present large amounts of text and/or numbers in an organized and easy-to-read 
fashion.  

• Row - A row runs horizontal in a table and is divided by borders. 
• Borders - Separating lines in the table. 
• Column - A column runs perpendicular in a table and is divided by borders. 
• Cell - A cell is the box that is created when your rows and your columns intersect each other. The 

cell contains your data or information. 
Creating Tables Using the Insert Table Dialog Box: 

• Choose Table Insert Table from the menu bar.  
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• The Insert Table dialog box appears.  
• In the Name field, type a name for the table.  
• In the Size fields, define the number of Columns and Rows that you want to include in the table. 

You can add more columns and rows later. To add rows, press press Tab at the end of a row.  
• In the Options fields, leave or remove checkmarks when you want to indicate the following:  

• A Header is to be included or not 
• Repeat header if the table spans more than one page. 
• Don't split the table, which prevents the table from spanning more than one page. 
• Add a border around the table cells. 

• Click the OK button to insert the table into your document.  
Entering Text in an OpenOffice.org Table 
Click anywhere inside a table cell and begin typing information information.  
To Move Around in a Table: 

• Use the Tab key or right arrow key to move right.  
• Use Shift + Tab or the left arrow key to move left.  
• The up and down arrow keys will move the insertion point above or below its current location.  

To Select Text in Tables: 
• A cell: triple click inside cell.  
• A row: Move mouse to left of margins, click the left mouse button, and drag to the end of the 

row.  
• Multiple rows: Select the first row, click and drag the number of rows desired.  
• A column: Move the mouse above the column, click the left mouse button and drag downward 

to the end of the column.  
• Multiple columns: Select the first column, click and drag across both columns and rows. 

To Format Text in Tables: 
• Select the text that you want to format. 
• Choose Format Character from the menu bar.  
• Access the different tabs to perform the following functions:  

o Change font, typeface, and size 
o Change font color. 
o Bold, underline, or italicize text 
o Apply font effects 
o Change the position of text (superscript, normal, subscript)  
o Rotate text in a table cell 
o Add a hyperlink to text 

Modifying Table Structure 
To Add Rows: 

• Move the insertion point to the last cell in the table and press the Tab key. 
To Insert Rows in the Middle of the Table: 

• Place the insertion point anywhere in the table.  

• Click the Insert Row button. 
To Delete Rows: 

• Select the row(s) you want to delete.  

• Choose Delete Row button. 
To Insert a Column: 

• Position the mouse pointer where you want to insert the extra column.  

• Click the Insert Column button. 
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To Delete Columns: 
• Position the mouse pointer in the column that you want to delete.  

• Click the Delete Column button. 
To Adjust Columns and Cell Width: 
Method 1: 

• Hover the insertion point over the border between the row and column.  
• The insertion point changes to a double-headed arrow.  
• Drag the border in either direction.  

 
Method 2: 

• Click anywhere in the table cell that you want to change. 
• Point to the associated marker on the ruler and click-and-drag to the left or right to make the 

margin larger or smaller.  
For example, grab the marker associated with the right margin of the middle column if you want 
to make the middle column larger or smaller. 

• Release the left mouse button when the column divider reaches its new location. 
Adding Borders and Shading 
To Change the Border: 

• Select the cells where you want to apply background color.  
• Click the Background Colors button and choose the color you want from the Background 

dialogue box.  
To Apply a Border: 

• Select the cells where you want to apply a border.  
• Click the Borders button drop-down menu and choose the border you want from the Borders 

dialogue box.  

 
To Delete a Table from the Document: 

• Place the mouse pointer at the top of the table - just below the paragraph above your table. 
• Click-and-drag over and downward to highlight the table. (Continue to click-and-drag until you 

have highlighted the entire table.)  
• Press the Delete key. 

To Search for Text: 
• Choose Edit Find & Replace from the menu bar.  
• The Find & Replace dialog box is displayed.  
• In the Search For field, type the word, or sequence of words, that's to be searched. 
• Click the Find button to display the first occurrence of the word.  
• To find the next occurrence of the word, click the Find button. 
• When finished, click the Close button. 

To Find and Replace Text: 
• Choose Edit Find & Replace from the menu bar.  
• The Find & Replace dialog box will appear.  
• In the Search For field, type the word, or sequence of words, that you want to search for. 
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• In the Replace with field, type the word, or sequence of words, that you want to use to replace 
the entry in the Search for field. 

• Click the Replace button to replace the first occurrence of the word. 
• To find the next occurrence of the word, click the Replace button, or click the Replace All button 

to replace all occurrences of the word. 
• When you are finished, click the Close button. 

Using the Thesaurus 
A Thesaurus is a source of information that you can use to look up synonyms (same word meanings). 
OpenOffice.org Writer gives you the capability to look up synonyms for a selected word and then 
replace that word with the synonym of your choice. 

• Select the word(s) you want to look up.  
• Choose Tools Thesaurus from the menu bar.  
• The Thesaurus dialog box will display the word that you looked up, as well as synonyms that 

you can use instead of the selected word.  
• Review all the synonyms for the selected word. Highlight the synonym you want to use to 

replace the word you selected. 
• Click the OK button. 

Hyphenating Words 
The hyphenation feature allows you to scan a document and highlight instances where you may want to 
hyphenate your text, on a word-by-word basis. 
To Apply Hyphenation to the Document: 

• Choose Tools Hyphenation from the menu bar.  
• Click either the Yes or No button to continue checking hyphenation at the beginning of the 

document. (Appears only if hyphenation was initiated somewhere other than the beginning of 
the document).  

• The Hyphenation dialog box displays the first Word in the document that can be hyphenated. 
Either click the Hyphenate button to hyphenate the word, or click the Next button to move to 
the next word that can be hyphenated.  

• When the hyphenation process is complete, the  confirmation appears.  
To set the Page Definitions for Your Document:  

• Choose Format Page from the menu bar.  
• Click on the Page tab in the Page Style:Default dialog box.  
• To change the Paper format, select a value from the Format drop-down box. Most documents are 

defined either as Letter format (8 ½ X 11) or Legal format (8 ½ X 14). Optionally, you can define 
custom Width and Height dimensions, as well as page Orientation (portrait or landscape).  

• To change the Margins of your document, type a new number (or use the drop-down arrow 
buttons) in the box next to the Left, Right, Top, or Bottom margin that you wish to change.  

• Click the OK button.  
To Add a Header to Your Document:  

• Choose Insert Header Default from the menu bar.  
• Start typing the header text for your document. Notice the Header style in the Paragraph Styles 

window is highlighted as you type the text.  
• When you are finished typing the header, click anywhere else in the body of the message. Notice 

that the Header style in the Paragraph Styles window changes to the style that you selected.  
To set the Header Definitions for Your Document:  

• Choose Format Page from the menu bar.  
• Click on the Header tab in the Page Style:Default dialog box. Notice that only the Header On 

field is active for selection.  
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• Click to place a checkmark alongside the Header On field. Notice all remaining fields become 
active for data entry.  

• Click to place a checkmark alongside the Same content left/right field if the header for both the 
odd pages and even pages are to contain the same content (e.g., chapter name).  

• Define both the Left margin and Right margin settings for the header.  
• Click the OK button to accept the header changes.  

To Add a Footer to Your Document:  
• Choose Insert Footer Default from the menu bar.  
• Scroll to the last blank line on the page and start typing the footer text for your document. Notice 

the Footer style in the Paragraph Styles window is highlighted as you type the text.  
To set the Footer Definitions for Your Document:  

• Choose Format Page from the menu bar.  
• Click on the Footer tab in the Page Style:Default dialog box. Notice that only the Footer On field 

is active for selection.  
• Click to insert a checkmark alongside the Footer On field. Notice all remaining fields become 

active for data entry.  
• Click to place a checkmark alongside the Same content left/right field if the header for both the 

odd pages and even pages are to contain the same content (e.g., chapter name).  
• Define both the Left margin and Right margin settings for the header.  
• Click the OK button to accept the header changes.  

To Add Columns to the Page Layout:  
• Choose Format Page from the menu bar.  
• Click on the Columns tab in the Page Style:Default dialog box.  
• Click on the up or down arrows associated with the Columns field - or click on one of the 

thumbnails to the right of this field - to define the number of columns that you would like to 
place on a page in your document.  

• In the Spacing field, define the amount of space that you would like in between each column on 
the page.  

• If you want columns to have different widths, then click the radio box to remove the checkmark 
next to AutoWidth. Then, define the exact width of each column in the Width field.  

• In the Separator Line field, select the line thickness (or leave the default to None) to separate each 
column on the page.  

• Click the OK button to accept the changes.  
To Apply Font Effects to Selected Text:  

• Highlight the text being selected for font effects.  
• Choose Format Character from the menu bar.  
• Click on the Font Effects tab in the Character dialog box.  
• In the Underlining field, select the underlining style that you want to use from the drop-down 

list (e.g., without, single, double, bold, dotted, dotted bold, etc.).  
• In the Strikethrough field, select the strikethrough style to use from the drop-down list (e.g., 

single line, double line, bold line, X's, or /'s).  
• In the Font Color field, select the color to be applied to the text.  
• In the Color field, select the color that you want to use for the underlined text.  
• In the Effects field, select an effects style from the drop-down list (e.g., capital letters, lower case 

letters, title, or small capitals).  
• In the Relief field, select a texture from the drop-down list (e.g., embossed, engraved, outline, 

shadow, or blinking).  
• Click the OK button.  
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To Change the Position of Selected Text:  
• Highlight the text that you want to format.  
• Choose Format Character from the menu bar.  
• Click on the Position tab in the Character dialog box.  
• In the Position area, set the subscript or superscript options for a character.  

o Superscript is used to reduce the font size of the selected text and raise it above the 
baseline.  

o The normal setting removes superscript or subscript formatting.  
o Subscript is used to reduce the font size of the selected text and lower it below the 

baseline.  
o Automatic sets the amount by which the selected text is raised or lowered in relation to 

the baseline.  
• In the Rotation / scaling area, set the rotation and the scaling options for the selected text.  

o 0 degrees, does not rotate the selected text.  
o 90 degrees, rotates the selected text to the left by 90 degrees.  
o 270 degrees, rotates the selected text to the right by 90 degrees.  

• Click the OK button.  
To Add a Hyperlink:  

• Highlight the text that you want to define as a hyperlink. 
• Choose Format Character from the menu bar (or Insert Hyperlink).  
• Click on the Hyperlink tab in the Character dialog box.  
• Type the URL or Web site address that you want to open when you click the hyperlink (e.g., 

http://www.gcflearnfree.org). If you want to open a file on your computer instead of a Web site, 
use the Browse button to locate and select the file that you want to use.  

• In the Name field, type a name for the hyperlink that you want to appear on the screen when 
you pass over the hyperlink with the cursor.  

• In the Target frame field, select the name of the frame where you want the linked file to open, or 
select a predefined frame from the list. If you leave this box blank, the linked file will open in the 
current browser window.  

• In the Visited links field, select a formatting style to apply to visited links from the list.  
• In the Unvisited links field, select a formatting style to apply to unvisited links from the list.  
• Click the OK button.  

To Apply a Colored Background to Text: 
• Highlight the text that you want to format. 
• Choose Format Character from the menu bar.  
• Click on the Background tab in the Character dialog box.  
• Click on the color that you want to apply to the background of your text.  
• Click the OK button. 

To Add a Text Box: 
• Choose Insert Frame from the menu 
• If not displayed, click the Type tab on the Framedialog box. 
• In the Size area, define the Width and Height of the frame. You can always resize the text box 

later by using the mouse.  
• In the Anchor area, specify whether the text box is to be anchored to the page, a specific 

paragraph, or a specific character. 
• In the Position area, specify the Horizontal and Vertical alignment of characters typed in the 

text box.  
• Click the OK button to add the frame to the page.  
• Click inside the text box and type the content you want to add to it.  
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To Insert a Picture From Your Computer: 
• Place the insertion point where you want to insert the picture.  
• Choose Insert Graphics From File from the menu bar.  
• The Insert Graphics dialog box is displayed.  
• In the Look in list, click the drive, folder, or Internet location that contains the graphic you want 

to insert in the document.  
• In the folder list, open the folder that contains the file and click on the graphic.  
• Click the Open button to insert the graphic into the document.  

To Move a Picture: 
• Click the left mouse button to select the graphic. Notice the square that is displayed around the 

selected graphic.  
• Using the mouse, drag the selected graphic to any position on the page. A dashed outline of the 

image box moves across the screen as you move the graphic with your mouse.  
• Release the left mouse button. The dotted square outline that you saw when the graphic was 

being moved goes away and is replaced by the actual moved graphic. Compare the following 
graphic to the graphic above. 

To Delete a Picture: 
• Click the left mouse button to select the graphic.  
• Press the Delete key on your keyboard. 

To Insert a Border Around a Graphic: 
• Click the left mouse button to select the graphic. Notice the square displayed around the selected 

graphic.  
• Choose Format Graphics from the menu bar. 
• Click the Borders tab on the Graphics dialog box is displayed.  
• In the Line arrangement area, select one of the four buttons to set no border, set all four borders, 

set left and right borders only, set top and bottom borders only, or set left border only.  
• In the Line area, select an entry that determines the thickness and color of the line 
• Click the OK button 

 

The Graphics dialog box gives you a variety of capabilities to apply to a graphic, including Type, 
Options, Text Wrap, Hyperlinks, Graphics, Crop, Background, and Macro. Look up the term "graphics" 
in the OpenOffice.org Writer help file for additional information. 
 
To Open a Microsoft Word file: 

• Choose File Open from the menu bar.  
• The Open dialog box appears. 
• In the Look in list, click the drive, folder, or Internet location that contains the file you want to 

open.  
• If you have created any folders, look in the folder list, and open the folder that contains the file. 

Once the file is displayed, click on the file you want to open.  
• Click in the Files of Type drop-down menu and select any of the following choices: 

o Microsoft Word 97/200/XP (*.doc) 
o Microsoft Word 97/200/XP Template (*.dot) 
o Microsoft Word 6.0 / 95 (*.doc) 
o Microsoft Word 95 Template (*.dot) 

• Click the Open button.  
To save a file in Microsoft Word format: 

• Choose File Save As from the menu bar.  
• The Save As dialog box appears. 
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• Click on the Save In: Drop-down menu and locate where you want to save the file. 
• Type a name for your file in the File Name: box.  
• Click in the Save As Type drop-down menu and select any of the following choices: 

o Microsoft Word 6.0 (.doc) 
o Microsoft Word 95 (.doc) 
o Microsoft Word 97/2000/XP (.doc) 

• Click the Save button. 
To Change OpenOffice.org Writer Defaults To Always Save Documents in Microsoft Word format: 

• Choose Tools Options 
• Make sure the General option is displayed for the Load/Save options 
• Click in the Always Save As drop-down menu and select either of the three Microsoft Word 

options that are compatible to your system: 
o Microsoft Word 6.0 
o Microsoft Word 95 
o Microsoft Word 97/2000/XP 

• Click the OK button. 
To Export a File to PDF: 

• Choose File Export as PDF from the menu bar. 
• The Export dialog box opens. 
• Click on Save In from the drop-down menu and locate where you would like to save your file. 

Choose 3 1/2 Floppy (A:) to save the file to a floppy disk or Local Disk (C:) to save the file to 
your computer.  

• Type a name for your file in the File Name: box.  
• Click the Save button. 

To save a file in HTML format: 
• Choose File Save As from the menu bar.  
• The Save As dialog box appears. 
• Click on the Save In: Drop-down menu and locate where you want to save the file. 
• Type a name for your file in the File Name: box.  
• Click in the Save As Type drop-down menu and select the following: 

o HTML Document (OpenOffice.org.org Writer) (.html) 
• Click the Save button. 
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